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Product notice

This guide describes features that are
common to most models. Some features may
not be available on your computer.

Not all features are available in all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take
full advantage of Windows 8 functionality.
See for http://www.microsoft.com details.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole remedy
is to return the entire unused product
(hardware and software) within 14 days for
a refund subject to the refund policy of your
place of purchase.

For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).

http://www.microsoft.com


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Product Name

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

HP 355 G2 Notebook PC ×  

HP 350 G1 Notebook PC  ×

Processor

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

● AMD® A8-6410 2.00-GHz (turbo boost up to 2.40-GHz)
processor (1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W)

● AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz)
processor (1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W)

● AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W)

● AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W)

● AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W)

×  

● Intel® Core® i7-4500U 1.80-GHz processor (dual core, 15 W)

● Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W)

● Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W)

● Intel Pentium® 3558U 1.70-GHz processor (1600-MHz FSB,
2.0-MB L3 cache, 15 W)

● Intel Celeron® 2957U 1.40-GHz processor (1600-MHz FSB,
2.0-MB L3 cache, 15 W)

 ×
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Chipset

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Integrated soldered-on-circuit (SoC) fusion controller hub (FCH) ×  

Intel processor controller hub (PCH), SoC  ×

Panel

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

15.6-in, AntiGlare (AG), high-definition HD, light-emitting diode (LED),
low-voltage differential signalling (LVDS), 1366×768, SVA, display
panel with and without webcamera

× ×
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Graphics

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Switchable discrete graphics: AMD Radeon™ R5 M240; 2-GB
DDR3 with up to 2-GB of dedicated video memory (256 × 16 DDR3
@ 1-GHz, 4 pieces) or 1-GB DDR3 with up to 1-GB of dedicated
video memory (128 × 16 DDR3 @ 1-GHz, 4 pieces)

Internal graphics: Integrated universal memory architecture (UMA)
graphics:

● AMD Radeon R5 graphics on computer models equipped with
an AMD A8-6410 processor

● AMD Radeon R4 graphics on computer models equipped with
an AMD A6-6310 processor

● AMD Radeon R3 graphics on computer models equipped with
an AMD A4-6210 processor

● AMD Radeon R2 graphics on computer models equipped with
an AMD E2-6110 processor

● AMD Radeon R2 graphics on computer models equipped with
an AMD E1-6010 processor

×  

Switchable discrete graphics: AMD Radeon HD 8670M (Sun
XT); 2-GB DDR3 with up to 2-GB of dedicated video memory
(256 × 16 DDR3 @ 1-GHz, 4 pieces) or 1-GB DDR3 with up to 1-GB
of dedicated video memory (128 × 16 DDR3 @ 1-GHz, 4 pieces)

Internal graphics: Integrated UMA graphics:

● Intel HD Graphics 4400 on computer models equipped with an
Intel Core processor

● Intel HD Graphics on computer models equipped with an Intel
Pentium or Intel Celeron processor

 ×
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Memory

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Two customer-accessible/upgradable memory module slots

Support for DDR3L 1600-MHz PCL3-12800 dual channel memory

Support for 16384-MB of system memory in the following
configurations:

● 16384-MB total system memory (8192 MB × 2; not available
with 32-bit operating system)

● 8192-MB total system memory (4096 MB × 2; not available with
32-bit operating system)

● 4096-MB total system memory (4096 MB × 1; only memory
configuration supported in Brazil)

● 2048-MB total system memory (2048 MB × 1)

× ×

Flash cache

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Support for 32-GB mSATA solid-state drive  ×
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Primary storage

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Support for 6.35-cm (2.5-in) hard drives in 7.0-mm (.28-in) and
9.5-mm (.37-in) thickness

Support for mSATA

Support for hard drive protection

Support for the following hard drives:

● 1-GB, 5400-rpm, SATA, 7.0-mm hard drive

● 750-GB, 5400-rpm, SATA, 7.0-mm hard drive

● 500-GB, 5400-rpm, SATA, 7.0-mm hard drive

× ×

Support for 500-GB, 7200-rpm, SATA, 7.0-mm hard drive

Support for Intel Smart Response Technology Accelerometer

 ×

Optical drive

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

DVD±RW Double Layer with SuperMulti Drive

9.5-mm tray load

SATA

Fixed (not modular)

Support for zero-power optical drive

Support for no optical drive option

× ×
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Audio and video

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

HP TrueVision HD webcamera (fixed/no tilt with activity light),
1280×720 by 30 frames per second

Support for non-webcamera option

Dual digital microphones

Stereo speakers (2)

DTS Sound

× ×

Ethernet

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Integrated 10/100/1000 network interface card (NIC) × ×

Wireless networking

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Integrated wireless local area network (WLAN) options by way of
wireless module

Two WLAN antennas built into display assembly

Support for the following WLAN formats:

● Atheros AR9485 802.11bgn WiFi Adapter

● Broadcom BCM943228HMB 802.11abgn 2×2 Wi-Fi Adapter,
Broadcom Bluetooth® 4.0 Adapter

× ×

Support for the Realtek RTL8723BE 802.11bgn 1×1 + BT 4 LE
Combo Adapter

×  

Support for the Ralink RT3290LE 802.11bgn 1×1 WiFi and Bluetooth
4.0 Combo Adapter

 ×
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External expansion

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

HP 2-in-1 multiformat Digital Media Reader Slot with push-push
technology. Reads data from and writes data to digital memory cards
such as Secure Digital (SD).

× ×

Ports

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

● AC adapter, HP Smart (4.5-mm barrel)

● Audio-in (mono microphone)/audio-out (stereo headphone)
combo jack

● HDMI v1.4 supporting up to 1920×1080 @ 60-Hz

● RJ45 (Ethernet)

● USB 3.0 (2)

● USB 2.0 (1)

● VGA (Dsub 15 pin) supporting: 1080p external resolution @ 60-
Hz, hot plug and unplug and autodetection for correct output to
wide-aspect vs. standard aspect video

× ×

Keyboard/pointing devices

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Full-size, island-style, spill-resistant keyboard

Touchpad Requirements:

● Default on for 2-finger scroll and pinch

● Multitouch gestures enabled

● Taps enabled as default

× ×
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Power requirements

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Support for removable 4-cell, 48-WHr, 3.20-AHr, Li-ion battery and 4-
cell, 41-WHr, 2.80-AHr, Li-ion battery

Support for the following AC adapters:

● 90-W AC adapter (PFC S-3P, 4.5-mm; not supported in India
and the People's Republic of China)

● 90-W AC adapter (PFC, SMT-3P, EM, 4.5-mm; for use only in
India and the People's Republic of China)

● 65-W AC adapter (non-PFC S-3P, 4.5-mm; not supported in
India and the People's Republic of China)

● 65-W HP Smart adapter (non-PFC, EM, 4.5-mm; for use only in
India and the People's Republic of China)

× ×

Security

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Support for fingerprint reader (support for non fingerprint reader
option) and security lock

× ×
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Operating system

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

Preinstalled:

● Microsoft Windows 8.1 Chinese Market 64-bit (only available
with the People's Republic of China Country Loc)

● Microsoft Windows 8.1 Emerging Market 64-bit

● Microsoft Windows 8.1 Emerging Market 64-bit MSNA (for use
only in Latin America)

● Microsoft Windows 8.1 ML 64-bit

● Microsoft Windows 8.1 Professional 64-bit

● Microsoft Windows 8.1 Professional 64-bit DPK with Microsoft
Windows 7 Professional 64-bit image (not available with
the People's Republic of China Country Loc)

Restore Media–DRDVD:

● DRDVD Microsoft Windows 8.1 (available with any Windows
8.1 operating system; required with any Windows 8.1
downgrade operating system)

● DRDVD Microsoft Windows 8 (available with any Windows 8
operating system; required with any Windows 8 downgrade
operating system)

● Microsoft Windows 7 (available with any Windows 7 or
Windows 8 downgrade operating system)

● SRDVD SuSE Linux Enterprise (SLED, service pack 2, 64-bit;
available only with FreeDOS 2.0 and SuSE)

Restore Media–OSDVD: System Recovery Disc (SSRD)

OSDVD: Microsoft Windows 8.1 Professional 64-bit (include in
Windows 8.1 downgrade operating system AV only, do not include
for Asia Pacific countries/regions or the People's Republic of China)

Web-only support:

● Microsoft Windows 8.1 Chinese Market 64-bit

● Microsoft Windows 8.1 Emerging Market 64-bit

● Microsoft Windows 8.1 ML 64-bit

● Microsoft Windows 8.1 Professional 64-bit

● Microsoft Windows 7 Professional 32-bit

× ×
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Serviceability

Description Computer models
equipped with

an AMD processor

Computer models
equipped with

an Intel processor

End user replaceable part:

● AC adapter

● Battery (system)

● Hard drive

● Keyboard

● Memory module

● Optical drive

● Solid-state drive

● WLAN module

× ×
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2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with WLANs.

(2) Internal microphones (2) Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam
(select models only)

Records video and captures photographs. Some models allow you to video
conference and chat online using streaming video.

For information on using the webcam, access HP Support Assistant. To access HP
Support Assistant, from the Start screen, select the HP Support Assistant app.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. To access this guide, from the Start screen, type support, and
then select the HP Support Assistant app.
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Buttons, speakers, and fingerprint reader (select
models only)

Item Component Description

(1) Power button ● When the computer is off, press the button to turn on the computer.

● When the computer is on, press the button briefly to initiate Sleep.

● When the computer is in the Sleep state, press the button briefly to
exit Sleep.

● When the computer is in Hibernation, press the button briefly to
exit Hibernation.

CAUTION: CAUTION: Pressing and holding down the power button will result
in the loss of unsaved information.

If the computer has stopped responding and Windows shutdown procedures are
ineffective, press and hold the power button for at least 5 seconds to turn off
the computer.

NOTE: For select models, the Intel Rapid Start Technology feature is enabled at
the factory. Rapid Start Technology allows your computer to resume quickly
from inactivity.

To learn more about your power settings, see your power options. From the Start
screen, type power, select Power and sleep settings, and then select
Power and sleep from the list of applications.
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Item Component Description

(2) Speakers Produce sound.

(3) Fingerprint reader
(select models only)

Allows a fingerprint logon to Windows, instead of a password logon.

Keys

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with a
function key, the num lk key, the esc key, or other keys.

(3) Windows button Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when pressed in combination with the
fn key.

(5) Function keys Execute frequently used system functions when pressed in combination with the
fn key.

Keys 13



Lights

Item Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a powersaving state. The
computer shuts off power to the display and other unneeded components.

● Off: The computer is off or in Hibernation. Hibernation is a power-saving
state that uses the least amount of power.

NOTE: For select models, the Intel Rapid Start Technology feature is enabled at
the factory. Rapid Start Technology allows your computer to resume quickly
from inactivity.

(2) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(3) Wireless light On: An integrated wireless device, such as a WLAN device and/or a Bluetooth
device, is on.

NOTE: On some models, the wireless light is amber when all wireless devices
are off.

(4) Fingerprint reader (select
models only)

Allows a fingerprint logon to Windows, instead of a password logon.
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Item Component Description

(5) TouchPad light ● On: The TouchPad is off.

● Off: The TouchPad is on.

(6) Caps lock light On: Caps lock is on, which switches the keys to all capital letters.

TouchPad

Item Component Description

(1) TouchPad on/off button
and light

Turns the TouchPad on and off.

● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(2) TouchPad zone Moves the pointer and selects or activates items on the screen.

(3) Left TouchPad button Functions like the left button on an external mouse.

(4) Right TouchPad button Functions like the right button on an external mouse.
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Front

Item Component Description

(1) Memory card reader Reads optional memory cards that store, manage, share, or access information.
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Left side

Item Component Description

(1) Power connector Connects an AC adapter.

(2) AC adapter/Battery light ● White: The AC adapter is connected to external power and the battery is
fully charged.

● Amber: The AC adapter is connected to external power and the battery
is charging.

● Off: The AC adapter is not connected to external power.

(3) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal components
and prevent overheating. It is normal for the internal fan to cycle on and off
during routine operation.

(4) External monitor port Connects an external VGA monitor or projector.

(5) HDMI port Connects an optional video or audio device, such as a high-definition television,
any compatible digital or audio component, or a high-speed HDMI device.

(6) RJ-45 (network) jack Connects a network cable.

● Green (left): The network is connected.

● Amber (right): The network is showing activity.

(7) USB 3.0 ports Each USB 3.0 port connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner or USB hub.
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Right side

Item Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a powersaving state. The
computer shuts off power to the display and other unneeded components.

● Off: The computer is off or in Hibernation. Hibernation is a power-saving
state that uses the least amount of power.

NOTE: For select models, the Intel Rapid Start Technology feature is enabled at
the factory. Rapid Start Technology allows your computer to resume quickly
from inactivity.

(2) Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard drive. (select
models only)

(3) Audio-out (headphone)
jack/Audio-in
(microphone) combo jack

Produces sound when connected to optional powered stereo speakers,
headphones, earbuds, a headset, or television audio. Also connects an optional
headset microphone.

WARNING! To reduce the risk of personal injury, adjust the volume before
putting on headphones, earbuds, or a headset. For additional safety information,
see the Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the computer speakers
are disabled.

NOTE: Be sure that the device cable has a 4-conductor connector that supports
both audio-out (headphone) and audio-in (microphone).

(4) USB 2.0 port Connects an optional USB device, such as a keyboard, mouse, external drive,
printer, scanner or USB hub.

(5) Optical drive (select
models only)

Depending on your computer model, reads an optical disc or reads and writes to
an optical disc.

(6) Optical drive eject button
(select models only)

Releases the optical drive disc tray.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it may not
prevent the computer from being mishandled or stolen.

18 Chapter 2   External component identification



Bottom

Item Component Description

(1) Battery cover release
latch and lock

Releases the battery cover over the battery bay.

(2) Battery bay Holds the battery.

(3) Memory module
compartment cover

Provides access to the keyboard screw, memory module slots, and optical
drive screw.

(4) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal components
and prevent overheating. It is normal for the internal fan to cycle on and off
during routine operation.

(5) Service cover Provides access to the hard drive bay, the WLAN module slot, and the solid-state
drive slot.

CAUTION: To prevent an unresponsive system, replace the wireless module
only with a wireless module authorized for use in the computer by the
governmental agency that regulates wireless devices in your country or region.
If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact support through Help
and Support.
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3 Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Locating the serial number, product number, and
model number

The serial number, product number, and model number of your computer are located on the bottom
of the computer. You may need the information when you travel internationally or when you
contact support.
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly components on page 31.

(2) Keyboard (includes keyboard cable):

 For use on all computer models:

 For use only in Belgium 758027-A41

 For use only in Bulgaria 758027-261

 For use only in France 758027-051

 For use only in Germany 758027-041

 For use only in Greece 758027-151

 For use only in Hungary 758027-211

 For use only in Israel 758027-BB1

 For use only in Italy 758027-061

 For use only in the Netherlands 758027-B31

 For use only in Portugal 758027-131

 For use only in Romania 758027-271

 For use only in Russia 758027-251

 For use only in Saudi Arabia 758027-171

 For use only in Slovenia 758027-BA1

 For use only in Spain 758027-071

 For use only in Turkey 758027-141

 For use only in the United Kingdom and Singapore 758027-031

 For use only in the United States 758027-001

 For use only on computer models equipped with an Intel processor:

 For use only in Canada 758027-DB1

 For use only in the Czech Republic and Slovakia 758027-FL1

 For use only in Denmark, Finland, and Norway 758027-DH1

 For use only in Northwest Africa 758027-FP1

 For use only in Switzerland 758027-BG1

 For use only in Taiwan 758027-AB1

(3) Top cover (includes TouchPad and TouchPad cable):

 For use only on computer models equipped with a fingerprint reader 758051-001

 For use only on computer models not equipped with a fingerprint reader 758050-001

(4) Card reader board (includes cable and double-sided adhesive) 758043-001
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(5) Power button board (includes cable and double-sided adhesive) 758044-001

(6) Fingerprint reader module (includes cable and double-sided adhesive) 758062-001

(7) TouchPad button board (includes TouchPad cable, TouchPad button board cable,
and double-sided adhesive)

758045-001

(8) Speaker Kit (includes left and right speakers and cables) 758053-001

(9) System board (includes replacement thermal material):

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Professional operating system

777342-601

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Standard operating system

777342-501

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and a non-Windows 8 operating system

777342-001

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Professional operating system

777341-601

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Standard operating system

777341-501

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and a non-Windows 8 operating system

777341-001

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and the Windows 8 Professional operating system

777340-601

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and the Windows 8 Standard operating system

777340-501

 Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and a non-Windows 8 operating system

777340-001

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Professional operating system

764691-601
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 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Standard operating system

764691-501

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-
GHz, 4 pieces), and a non-Windows 8operating system

764691-001

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Professional operating system

764689-601

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and the Windows 8 Standard operating system

764689-501

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240
graphics subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-
GHz, 4 pieces), and a non-Windows 8operating system

764689-001

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and the Windows 8 Professional operating system

764685-601

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and the Windows 8 Standard operating system

764685-501

 Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with
UMA memory, and a non-Windows 8 operating system

764685-001

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and the
Windows 8 Professional operating system

764690-601

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and the
Windows 8 Standard operating system

764690-501

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and a non-
Windows 8 operating system

764690-001

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and the
Windows 8 Professional operating system

764688-601
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 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and the
Windows 8 Standard operating system

764688-501

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to
1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and a non-
Windows 8 operating system

764688-001

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system

764684-601

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system

764684-501

 Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and a non-
Windows 8 operating system

764684-001

 Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and the Windows
8 Professional operating system

764687-601

 Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and the Windows
8 Standard operating system

764687-501

 Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and a non-
Windows 8 operating system

764687-001

 Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and the Windows
8 Professional operating system

764686-601

 Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and the Windows
8 Standard operating system

764686-501

 Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and a non-
Windows operating system

764686-001

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Professional operating system

758035-601

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Standard operating system

758035-501

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a
non-Windows 8 operating system

758035-001
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 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Professional operating system

758040-601

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Standard operating system

758040-501

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a
non-Windows 8 operating system

758040-001

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Professional operating system

758034-601

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Standard operating system

758034-501

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a
non-Windows 8 operating system

758034-001

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Professional operating system

758039-601

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Standard operating system

758039-501

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a
non-Windows 8 operating system

758039-001

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Professional operating system

758033-601

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and
the Windows 8 Standard operating system

758033-501

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a
non-Windows 8 operating system

758033-001

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Professional operating system

758038-601

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and
the Windows 8 Standard operating system

758038-501

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a
non-Windows 8 operating system

758038-001
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 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Professional operating system

758036-601

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Standard operating system

758036-501

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and a non-Windows 8 operating system

758036-001

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and the Windows 8 Professional operating system

758041-601

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and the Windows 8 Standard operating system

758041-501

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and a non-Windows 8 operating system

758041-001

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Professional operating system

758037-601

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Standard operating system

758037-501

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and a non-Windows 8 operating system

758037-001

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and the Windows 8 Professional operating system

758042-601

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and the Windows 8 Standard operating system

758042-501

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and a non-Windows 8 operating system

758042-001

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

758030-601

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

758030-501

 Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system

758030-001
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 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

758029-601

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

758029-501

 Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system

758029-001

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

758028-601

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

758028-501

 Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system

758028-001

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system

758031-601

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Standard operating system

758031-501

 Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

758031-001

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system

758032-601

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Standard operating system

758032-501

 Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

758032-001

(10) Optical drive cable 758064-001

(11) RTC battery 718440-001

(12) Fan (includes cable) 746657-001

(13) Heat sink (includes replacement thermal material)

 For use only on computer models equipped with a graphics subsystem with
discrete memory

746658-001

 For use only on computer models equipped with a graphics subsystem with
UMA memory

746659-001

(14) Audio/USB board (includes audio jack, USB port, and cable) 758046-001
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(15) Power connector cable 758054-001

(16) Base enclosure 758047-001

 Rubber Kit (not illustrated, includes base enclosure rubber feet) 758063-001

(17) Battery, 4-cell, 41-Whr, 2.80-AHr, Li-ion 752237-001

(18) Memory module (PCL3, 12800, 1600-MHz):

 8 GB 693374-001

 4 GB 691740-001

 2 MB for use only on computer models equipped with an AMD processor 652972-001

 2 GB for use only on computer models equipped with an Intel processor 691739-001

(19) 32-GB mSATA solid-state drive (for use only on computer models equipped with
an Intel processor)

753909-001

(20) WLAN module:

 Atheros AR9485 802.11bgn WiFi Adapter for use on all computer models 675794-001

 Broadcom BCM943228HMB 802.11abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth
4.0 Adapter for use on all computer models

730668-001

 Realtek RTL8723BE 802.11bgn 1×1 + BT 4 LE Combo Adapter for use only on
computer models with an AMD processor

753077-001

 Ralink RT3290LE 802.11bgn 1×1 WiFi and Bluetooth 4.0 Combo Adapter for use
only on computer models equipped with an Intel processor

690020-001

(21) Hard drive (does not include hard drive bracket or hard drive connector adapter):

NOTE: The hard drive bracket and hard drive connector adapter are included in the Hard Drive Hardware Kit,
spare part number 758048-001. See Mass storage devices on page 33 for more information on the Hard Drive
Hardware Kit.

 1-TB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 676521-001

 750-GB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 634250-001

 500-GB, 7200-rpm, SATA, 7.0-mm hard drive for use only on computer models
equipped with an Intel processor

678101-001

 500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models 683802-001

(22) DVD±RW Double Layer with SuperMulti Drive:

 For use only on computer models equipped with an AMD processor 767487-001

 For use only on computer models equipped with an Intel processor 763275-001

 Optical Drive Hardware Kit (includes optical drive bezel, optical drive bracket,
and optical drive bracket screws)

758049-001

 Plastics Kit, includes:

NOTE: See Plastics Kit on page 32 for more Plastics Kit information.

758052-001

(23) Memory module compartment cover (includes one captive screw, secured by an O-ring)
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(24) Service cover (includes one captive screw, secured by an O-ring)

 Optical drive bay space saver (not illustrated)
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(1) Display bezel:

 For use only on computer models equipped with an AMD processor:

 For use only on computer models equipped with a webcam 766642-001

 For use only on computer models not equipped with a webcam 764696-001

 For use only on computer models equipped with an Intel processor:

 For use only on computer models equipped with a webcam 758055-001

 For use only on computer models not equipped with a webcam 758056-001

(2) 15.6-in, HD, SVA display panel 761784-001

 Display Hinge Kit, includes: 758061-001

(3a) Left and right display hinge brackets

(3b) Left and right display hinges

(4) Webcam/microphone module (includes double-sided adhesive):

 For use only on computer models equipped with an AMD processor 766238-001
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 For use only on computer models equipped with an Intel processor 746667-001

(5) Display panel cable:

 For use only on computer models equipped with a webcam 758059-001

 For use only on computer models not equipped with a webcam 758058-001

(6) Antenna Kit,.includes: 758060-001

(7) Display enclosure 758057-001

Plastics Kit

Item Component Spare part number

 Plastics Kit, includes: 758052-001

(1) Service cover (includes one captive screw, secured by an O-ring)

(2) Memory module compartment cover (includes one captive screw, secured by an O-ring)

(3) Optical drive bay space saver
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(1) DVD±RW Double Layer with SuperMulti Drive

 For use only on computer models equipped with an AMD processor 767487-001

 For use only on computer models equipped with an Intel processor 763275-001

 Optical Drive Hardware Kit (not illustrated, includes optical drive bezel, optical
drive bracket, and optical drive bracket screws)

758049-001

(2) 32-GB mSATA solid-state drive (for use only on computer models equipped with
an Intel processor)

753909-001

(3) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the Hard Drive
Hardware Kit.

 1-TB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 676521-001

 720-GB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 634250-001

 500-GB, 7200-rpm, SATA, 7.0-mm hard drive for use only on computer models
equipped with an Intel processor

678101-001

 500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models 683802-001

 Hard Drive Hardware Kit, includes: 758048-001

Mass storage devices 33



Item Component Spare part number

(4) Hard drive bracket

(5) Hard drive connector adapter

 Screws (not illustrated)

Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart adapter (non-PFC S-3P, 4.5-mm) for use on all computer models 710412-001

45-W HP Smart adapter (non-PFC, RC, 4.5-mm) for use only on computer models equipped with
an AMD processor

741727-001

65-W HP Smart adapter (non-PFC, EM, 4.5-mm) for use only on computer models equipped with
an Intel processor

714657-001

Carrying case:

HP top load business carrying case 718550-001

HP top load essential carrying case 679921-001

HP HDMI-to-VGA adapter 701943-001

HP ultraslim keyed cable lock 703372-001

Mouse:

HP comfort grip wireless mouse 691922-001

HP USB laser mouse 674318-001

HP USB optical travel mouse 434594-001

Power cord for use only on computer models equipped with an Intel processor (3-pin, black, 1.83-m):

For use in Australia 490371-011

For use in Europe 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in the South Africa 490371-AR1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom and Singapore 490371-031
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Power cord for use only on computer models equipped with an AMD processor (3-pin, black, 1.00-m):

For use in Denmark 755530-081

For use in Europe 755530-021

For use in Israel 755530-BB1

For use in Italy 755530-061

For use in North America 755530-001

For use in South Africa 755530-AR1

For use in Switzerland 755530-111

For use in the United Kingdom and Singapre 755530-031

Screw Kit 760284-001
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434594-001 HP USB optical travel mouse

490371-001 Power cord for use only on computer models equipped with an Intel processor in North America (3-
pin, black, 1.83-m)

490371-011 Power cord for use only on computer models equipped with an Intel processor in Australia (3-pin,
black, 1.83-m)

490371-021 Power cord for use only on computer models equipped with an Intel processor in Europe (3-pin,
black, 1.83-m)

490371-031 Power cord for use only on computer models equipped with an Intel processor
in the United Kingdom and Singapore(3-pin, black, 1.83-m)

490371-061 Power cord for use only on computer models equipped with an Intel processor in Italy (3-pin, black,
1.83-m)

490371-111 Power cord for use only on computer models equipped with an Intel processor in Switzerland (3-
pin, black, 1.83-m)

490371-AA1 Power cord for use only on computer models equipped with an Intel processor in the People's
Repubic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use only on computer models equipped with an Intel processor in Taiwan (3-pin,
black, 1.83-m)

490371-AR1 Power cord for use only on computer models equipped with an Intel processor in South Africa (3-
pin, black, 1.83-m)

490371-BB1 Power cord for use only on computer models equipped with an Intel processor in Israel (3-pin,
black, 1.83-m)

634250-001 750-GB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models (does not include
hard drive bracket, hard drive connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 746650-001.

652972-001 2-GB memory module for use only on computer models equipped with an AMD processor (PCL3,
12800, 1600-MHz)

674318-001 HP USB laser mouse

675794-001 Atheros AR9485 802.11b/g/n WiFi Adapter for use on all computer models

676521-001 1-TB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models (does not include hard
drive bracket, hard drive connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 746650-001.

678101-001 500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use only on computer models equipped with an
Intel processor (does not include hard drive bracket, hard drive connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 746650-001.

679921-001 HP top load essential carrying case
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683802-001 500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models (does not include
hard drive bracket, hard drive connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 746650-001.

690020-001 Ralink RT3290LE 802.11bgn 1×1 WiFi and Bluetooth 4.0 Combo Adapter for use only on
computer models equipped with an Intel processor

691739-001 2-GB memory module for use only on computer models equipped with an Intel processor (PCL3,
12800, 1600-MHz)

691740-001 4-GB memory module for use on all computer models (PCL3, 12800, 1600-MHz)

691922-001 HP comfort grip wireless mouse

693374-001 8-GB memory module for use on all computer models (PCL3, 12800, 1600-MHz)

701943-001 HP HDMI-to-VGA adapter

703372-001 HP ultraslim keyed cable lock

710412-001 65-W HP Smart adapter (non-PFC S-3P, 4.5-mm)

714657-001 65-W HP Smart adapter for use only on computer models equipped with an Intel processor (non-
PFC, EM, 4.5-mm)

718440-001 RTC battery (includes cable and double-sided adhesive)

718550-001 HP top load business carrying case

730668-001 Broadcom BCM943228HMB 802.11abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth 4.0 Adapter
for use on all computer models

741727-001 45-W HP Smart adapter for use only on computer models equipped with an AMD processor (non-
PFC, RC, 4.5-mm)

746657-001 Fan (includes cable)

746658-001 Heat sink for use only on computer models equipped with a graphics subsystem with
discrete memory (includes replacement thermal material)

746659-001 Heat sink for use only on computer models equipped with a graphics subsystem with UMA memory
(includes replacement thermal material)

746667-001 Webcam/microphone module for use only on computer models equipped with an Intel processor
(includes double-sided adhesive)

752237-001 4-cell, 41-WHr, 2.80-AHr, Li-ion battery

753077-001 Realtek RTL8723BE 802.11bgn 1×1 + BT 4 LE Combo Adapter for use only on computer models
equipped with an AMD processor

753909-001 32-GB mSATA solid-state drive (for use only on computer models equipped with an Intel processor)

755530-001 Power cord for use only on computer models equipped with an AMD processor
in North America (3-pin, black, 1.00-m)

755530-021 Power cord for use only on computer models equipped with an AMD processor in Europe (3-pin,
black, 1.00-m)

755530-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.00-m)
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755530-061 Power cord for use only on computer models equipped with an AMD processor in Italy (3-pin,
black, 1.00-m)

755530-081 Power cord for use only on computer models equipped with an AMD processor in Denmark (3-pin,
black, 1.00-m)

755530-111 Power cord for use only on computer models equipped with an AMD processor in Switzerland (3-
pin, black, 1.00-m)

755530-AR1 Power cord for use only on computer models equipped with an AMD processor in South Africa (3-
pin, black, 1.00-m)

755530-BB1 Power cord for use only on computer models equipped with an AMD processor in Israel (3-pin,
black, 1.00-m)

758027-001 Keyboard for use on all computer models in the United States (includes keyboard cable)

758027-031 Keyboard for use on all computer models in the United Kingdom and Singapore (includes
keyboard cable)

758027-041 Keyboard for use on all computer models in Germany (includes keyboard cable)

758027-051 Keyboard for use on all computer models in France (includes keyboard cable)

758027-061 Keyboard for use on all computer models in Italy (includes keyboard cable)

758027-071 Keyboard for use on all computer models in Spain (includes keyboard cable)

758027-131 Keyboard for use on all computer models in Portugal (includes keyboard cable)

758027-141 Keyboard for use on all computer models in Turkey (includes keyboard cable)

758027-151 Keyboard for use on all computer models in Greece (includes keyboard cable)

758027-171 Keyboard for use on all computer models in Saudi Arabia (includes keyboard cable)

758027-211 Keyboard for use on all computer models in Hungary (includes keyboard cable)

758027-251 Keyboard for use on all computer models in Russia (includes keyboard cable)

758027-261 Keyboard for use on all computer models in Bulgaria (includes keyboard cable)

758027-271 Keyboard for use on all computer models in Romania (includes keyboard cable)

758027-A41 Keyboard for use on all computer models in Belgium (includes keyboard cable)

758027-AB1 Keyboard for use only on computer models equipped with an Intel processor in Taiwan (includes
keyboard cable)

758027-B31 Keyboard for use on all computer models in the Netherlands (includes keyboard cable)

758027-BA1 Keyboard for use on all computer models in Slovenia (includes keyboard cable)

758027-BB1 Keyboard for use on all computer models in Israel (includes keyboard cable)

758027-BG1 Keyboard for use only on computer models equipped with an Intel processor in Switzerland
(includes keyboard cable)

758027-DB1 Keyboard for use only on computer models equipped with an Intel processor in Canada (includes
keyboard cable)

758027-DH1 Keyboard for use only on computer models equipped with an Intel processor in Denmark, Finland,
and Norway (includes keyboard cable)
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758027-FL1 Keyboard for use only on computer models equipped with an Intel processor in the Czech Republic
and Slovakia (includes keyboard cable)

758027-FP1 Keyboard for use only on computer models equipped with an Intel processor in Northwest Africa
(includes keyboard cable)

758028-001 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system (includes
replacement thermal material)

758028-501 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard operating system (includes
replacement thermal material)

758028-601 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional operating system
(includes replacement thermal material)

758029-001 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system (includes
replacement thermal material)

758029-501 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard operating system (includes
replacement thermal material)

758029-601 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional operating system
(includes replacement thermal material)

758030-001 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and a non-Windows 8 operating system (includes
replacement thermal material)

758030-501 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Standard operating system (includes
replacement thermal material)

758030-601 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W),
a graphics subsystem with UMA memory, and the Windows 8 Professional operating system
(includes replacement thermal material)

758031-001 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system (includes replacement thermal material)

758031-501 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system (includes replacement thermal material)

758031-601 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system (includes replacement thermal material)

758032-001 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system (includes replacement thermal material)
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758032-501 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system (includes replacement thermal material)

758032-601 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system (includes replacement thermal material)

758033-001 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758033-501 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758033-601 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758034-001 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758034-501 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758034-601 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758035-001 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758035-501 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758035-601 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758036-001 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and a non-Windows 8 operating system (includes replacement thermal material)

758036-501 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Standard operating system (includes replacement
thermal material)

758036-601 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Professional operating system (includes replacement
thermal material)
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758037-001 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and a non-Windows 8 operating system (includes replacement thermal material)

758037-501 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Standard operating system (includes replacement
thermal material)

758037-601 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of
discrete memory, and the Windows 8 Professional operating system (includes replacement
thermal material)

758038-001 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758038-501 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758038-601 System board equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758039-001 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758039-501 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758039-601 System board equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758040-001 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and a non-
Windows 8 operating system (includes replacement thermal material)

758040-501 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Standard operating system (includes replacement thermal material)

758040-601 System board equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an
AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8
Professional operating system (includes replacement thermal material)

758041-001 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of
discrete memory, and a non-Windows 8 operating system (includes replacement thermal material)

758041-501 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete
memory, and the Windows 8 Standard operating system (includes replacement thermal material)

Sequential part number listing 41



Spare part number Description

758041-601 System board equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB
L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete
memory, and the Windows 8 Professional operating system (includes replacement thermal material)

758042-001 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete
memory, and a non-Windows 8 operating system (includes replacement thermal material)

758042-501 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete
memory, and the Windows 8 Standard operating system (includes replacement thermal material)

758042-601 System board equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-
MB L3 cache, 15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete
memory, and the Windows 8 Professional operating system (includes replacement thermal material)

758043-001 Card reader board (includes cable and double-sided adhesive)

758044-001 Power button board (includes cable and double-sided adhesive)

758045-001 TouchPad button board (includes TouchPad cable, TouchPad button board cable, and double-
sided adhesive)

758046-001 Audio/USB board (includes audio jack, USB port, and cable)

758047-001 Base enclosure

758048-001 Hard Drive Hardware Kit

758049-001 Optical Drive Hardware Kit (not illustrated, includes optical drive bezel, optical drive bracket, and
optical drive bracket screws)

758050-001 Top cover for use only on computer models equipped with a fingerprint reader (includes TouchPad)

758051-001 Top cover for use only on computer models not equipped with a fingerprint reader
(includes TouchPad)

758052-001 Plastics Kit

NOTE: See Plastics Kit on page 32 for more Plastics Kit information.

758053-001 Speaker Kit (includes left and right speakers and cables)

758054-001 Power connector cable

758055-001 Display bezel for use only on computer models equipped with an Intel processor and a webcam

758056-001 Display bezel for use only on computer models equipped with an Intel processor but not equipped
with a webcam

758057-001 Display enclosure

758058-001 Display panel cable for use only on computer models not equipped with a webcam

758059-001 Display panel cable for use only on computer models equipped with a webcam

758060-001 Antenna Kit (includes left and right wireless antenna cables and transceivers)

758061-001 Display Hinge Kit (includes left and right display hinges

758062-001 Fingerprint reader module (includes cable and double-sided adhesive)
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758063-001 Rubber Kit

758064-001 Optical drive cable

760284-001 Screw Kit

761784-001 15.6-in, HD, SVA display panel

763275-001 DVD±RW Double Layer with SuperMulti Drive for use only on computer models equipped with an
Intel processor

764684-001 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system (includes replacement thermal material)

764684-501 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system (includes replacement thermal material)

764684-601 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system (includes replacement thermal material)

764685-001 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system (includes replacement thermal material)

764685-501 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system (includes replacement thermal material)

764685-601 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system (includes replacement thermal material)

764686-001 System board equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system (includes replacement thermal material)

764686-501 System board equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system (includes replacement thermal material)

764686-601 System board equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2
cache, dual core, 10 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system (includes replacement thermal material)

764687-001 System board equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system (includes replacement thermal material)

764687-501 System board equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system (includes replacement thermal material)

764687-601 System board equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, dual core, 15 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system (includes replacement thermal material)
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764688-001 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of
dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and a non-Windows 8
operating system (includes replacement thermal material)

764688-501 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of
dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Standard
operating system (includes replacement thermal material)

764688-601 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of
dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Professional
operating system (includes replacement thermal material)

764689-001 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and a
non-Windows 8 operating system (includes replacement thermal material)

764689-501 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Standard operating system (includes replacement thermal material)

764689-601 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Professional operating system (includes replacement thermal material)

764690-001 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of
dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and a non-Windows 8
operating system (includes replacement thermal material)

764690-501 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of
dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Standard
operating system (includes replacement thermal material)

764690-601 System board equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2
cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of
dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Professional
operating system (includes replacement thermal material)

764691-001 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and a
non-Windows 8 operating system (includes replacement thermal material)

764691-501 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Standard operating system (includes replacement thermal material)

764691-601 System board equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Professional operating system (includes replacement thermal material)
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Spare part number Description

764696-001 Display bezel for use only on computer models equipped with an AMD processor but without
a webcam

766238-001 Webcam/microphone module for use only on computer models equipped with an AMD processor

766642-001 Display bezel for use only on computer models equipped with an AMD processor and a webcam

767487-001 DVD±RW Double Layer with SuperMulti Drive for use only on computer models equipped with an
AMD processor

777340-001 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system (includes replacement thermal material)

777340-501 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system (includes replacement thermal material)

777340-601 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system (includes replacement thermal material)

777341-001 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and a
non-Windows 8 operating system (includes replacement thermal material)

777341-501 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Standard operating system (includes replacement thermal material)

777341-601 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 1.0-GB of dedicated video memory (128×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Professional operating system (includes replacement thermal material)

777342-001 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and a
non-Windows 8 operating system (includes replacement thermal material)

777342-501 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Standard operating system (includes replacement thermal material)

777342-601 System board equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor
(1600-MHz FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics
subsystem with up to 2.0-GB of dedicated video memory (256×16 DDR3@1-GHz, 4 pieces), and
the Windows 8 Professional operating system (includes replacement thermal material)
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4 Removal and replacement
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 screw driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive computerop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5 Removal and replacement
procedures for Customer Self-
Repair parts

NOTE: The Customer Self-Repair program is not available in all locations. Installing a part not
supported by the Customer Self-Repair program may void your warranty. Check your warranty to
determine if Customer Self-Repair is supported in your location.

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Component replacement procedures
NOTE: Please read and follow the procedures described here to access and replace Customer Self-
Repair parts successfully.

NOTE: Details about your computer, including model, serial number, product key, and length of
warranty, are on the service tag at the bottom of your computer. See Locating the serial number,
product number, and model number on page 20 for details.

This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 7 screws that must be removed, replaced, and/or loosened when servicing
Customer Self-Repair parts. Make special note of each screw size and location during removal
and replacement.
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Battery

Description Spare part number

4-cell, 41-Whr, 2.80-AHr, Li-ion battery 752237-001

Before removing the disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

WARNING! To reduce potential safety issues, use only the battery provided with the computer, a
replacement battery provided by HP, or a compatible battery purchased from HP.

CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work or shut down the computer through
Windows before removing the battery.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) and battery lock (2) inwards to release the battery.

3. Remove the battery from the computer (3).

Reverse this procedure to install the battery.
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Service cover

NOTE: The service cover is included in the Plastics Kit, spare part number 758052-001.

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (See Battery on page 52).

Remove the service cover:

1. Loosen the Phillips PM2.5×4.5 captive screw (1) that secures the service cover to the computer.

2. Lift the rear edge of the service cover (2) until it rests at an angle.

3. Remove the service cover (3).

Reverse this procedure to install the service cover.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket or hard drive
connector adapter. The hard drive bracket and hard drive connector adapter are included in
the Hard Drive Hardware Kit, spare part number 758048-001. See Mass storage devices on page 33
for more information on the Hard Drive Hardware Kit.

Description Spare part number

1-TB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 676521-001

750-GB, 5400-rpm, SATA, 9.5-mm hard drive for use on all computer models 634250-001

500-GB, 7200-rpm, SATA, 7.0-mm hard drive for use only on computer models equipped with an
Intel processor

678101-001

500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use on all computer models 683802-001

Before removing the battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

5. Remove the service cover (see Service cover on page 53).

Remove the hard drive:

1. Release the zero insertion force (ZIF) connector (1) to which the hard drive connector cable is
attached, and then disconnect the hard drive connector cable (2) from the system board.
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2. Remove the hard drive (3) from the hard drive bay.

3. If it is necessary to disassemble the hard drive, perform the following steps:

a. Position the hard drive with the hard drive connector adapter toward you.

b. Release the left and right sides of the hard drive bracket (1) from the hard drive.

c. Remove the hard drive bracket (2) from the hard drive.
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d. Remove the hard drive connector adapter (3) from the hard drive.

The hard drive bracket and hard drive connector adapter are available in the Hard Drive
Hardware Kit, spare part number 746650-001.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Atheros AR9485 802.11bgn WiFi Adapter for use on all computer models 675794-001

Broadcom BCM943228HMB 802.11abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth 4.0 Adapter
for use on all computer models

730668-001

Realtek RTL8723BE 802.11bgn 1×1 + BT 4 LE Combo Adaptery for use only on computer models
equipped with an AMD processor

753077-001

Ralink RT3290LE 802.11bgn 1×1 WiFi and Bluetooth 4.0 Combo Adapter for use only on
computer models equipped with an Intel processor

690020-001

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

5. Remove the service cover (see Service cover on page 53).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module,
protective sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Solid-state drive

NOTE: This section applies only to computer models equipped with an Intel processor.

Description Spare part number

32-GB mSATA solid-state drive 753909-001

Before removing the solid-state drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

5. Remove the service cover (see Service cover on page 53).

Remove the solid-state drive:

1. Remove the Phillips PM2.0×3.0 screw (1) that secures the solid-state drive to the system board.
(The solid-state drive tilts up.)

2. Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.
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Reverse this procedure to install the solid-state drive.

Memory module

Description Spare part number

8 GB 693374-001

4 GB 691740-001

2 MB for use only on computer models equipped with an AMD processor 652972-001

2 GB for use only on computer models equipped with an Intel processor 691739-001

Before removing the memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

Remove the memory module:

1. Loosen the Phillips PM2.5×4.5 captive screw (1) that secures the memory module compartment
cover to the computer.

2. Lift the right edge of the memory module compartment cover (2) until it rests at an angle.
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3. Remove the memory module compartment cover (3).

The memory module compartment cover is included in the Plastics Kit, spare part number
746655-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.

Optical drive

Description Spare part number

DVD±RW Double Layer with SuperMulti Drive 763275-001

Optical Drive Hardware Kit (includes optical drive bezel, optical drive bracket, and optical drive
bracket screws)

758049-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

5. Remove the memory module compartment cover (see Memory module on page 60).

Remove the optical drive:

1. Position the computer with the left side toward you.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the optical drive to the computer.
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3. Use a thin plastic tool to press on the optical drive tab (2) and release the optical drive from
the computer.

4. Remove the optical drive (3).

Reverse this procedure to install the optical drive.
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Keyboard

Description Spare part number Description Spare part number

For use only in Belgium 758027-A41 For use only in Northwest Africa 758027-FP1

For use only in Bulgaria 758027-261 For use only in Portugal 758027-131

For use only in Canada 758027-DB1 For use only in Romania 758027-271

For use only in the Czech
Republic and Slovakia

758027-FL1 For use only in Russia 758027-251

For use only in Denmark,
Finland, and Norway

758027-DH1 For use only in Saudi Arabia 758027-171

For use only in France 758027-051 For use only in Slovenia 758027-BA1

For use only in Germany 758027-041 For use only in Spain 758027-071

For use only in Greece 758027-151 For use only in Switzerland 758027-BG1

For use only in Hungary 758027-211 For use only in Taiwan 758027-AB1

For use only in Israel 758027-BB1 For use only in Turkey 758027-141

For use only in Italy 758027-061 For use only in the United
Kingdom and Singapore

758027-031

For use only in the Netherlands 758027-B31 For use only in the United States 758027-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 52).

5. Remove the memory module compartment cover (see Memory module on page 60).
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Remove the keyboard:

1. Remove the two Phillips PM2.5×6.5 screws that secure the keyboard to the computer.

2. Partially open the computer.

3. Rest and secure the computer on its left side.

4. Insert a thin, plastic tool into the keyboard retention screw hole, and then press on the back of the
keyboard until the keyboard disengages from the computer.

5. Open the computer as far as it will open.

6. Slide the keyboard (1) toward the TouchPad as far as it will slide.
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7. Lift the rear edge of the keyboard (2) until it rests at an angle.

8. Swing the keyboard (1) up and forward until it rests upside down on the palm rest.

9. Release the ZIF connector (2) to which the keyboard cable is attached, and then disconnect the
keyboard cable (3) from the system board.

10. Remove the keyboard (4).

Reverse this procedure to install the keyboard.
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6 Removal and replacement
procedures for Authorized Service
Provider parts

CAUTION: Components described in this chapter should only be accessed by an authorized service
provider. Accessing these parts can damage the computer or void the warranty.

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.

There are as many as 50 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Top cover

Description Spare part number

For use only on computer models equipped with a fingerprint reader 758051-001

For use only on computer models not equipped with a fingerprint reader 758050-001

Before removing the top cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
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3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

NOTE: When replacing the top cover, be sure that the following components are removed from the
defective top cover and installed on the replacement top cover:

● Fingerprint reader module (See Fingerprint reader module on page 71)

● TouchPad button board (See TouchPad button board on page 72)

● Card reader board (See Card reader board on page 74)

● Power button board (See Power button board on page 75)

Remove the top cover:

1. Close the computer.

2. Turn the computer upside down with the front toward you.

3. Remove the two rubber feet (1).

NOTE: The rubber feet are included in the Rubber Kit, spare part number 746669-001.

68 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



4. Remove the ten Phillips PM2.5×6.5 screws (2) that secure the top cover to the base enclosure.

5. Remove the two Phillips PM2.0×2.0 broad head screws (1) in the optical drive bay that secure
the top cover to the base enclosure.

6. Remove the four Phillips PM2.0×2.0 broad head screws (2) in the hard drive bay that secure the
top cover to the base enclosure.
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7. Turn the computer right side up with the front toward you.

8. Open the computer as far as it will open.

9. Disconnect the following cables from the system board:

(1) Power button board ZIF connector and ribbon cable

(2) Card reader board ZIF connector and ribbon cable

(3) TouchPad button board ZIF connector and ribbon cable

(4) Fingerprint reader module ZIF connector and ribbon cable

10. Separate the rear edge of the top cover (1) from the base enclosure.

11. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Fingerprint reader module

Description Spare part number

Fingerprint reader module (includes cable and double-sided adhesive) 758062-001

Before removing the fingerprint reader module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

Remove the fingerprint reader module:

1. Turn the top cover upside down with the front toward you.

2. Release the ground tape (1) that secures the fingerprint reader module to the top cover.

3. Detach the fingerprint reader module cable (2) from the top cover. (The fingerprint reader module
cable is attached to the top cover with double-sided adhesive.)
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4. Remove the fingerprint reader module (3) and cable.

Reverse this procedure to install the fingerprint reader module.

TouchPad button board

Description Spare part number

TouchPad button board (includes TouchPad cable, TouchPad button board cable, and double-
sided adhesive)

758045-001

Before removing the TouchPad button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

72 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



Remove the TouchPad button board:

1. Turn the top cover upside down with the front toward you.

2. Release the ZIF connector (1) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (2) from the TouchPad board.

3. Remove the two Phillips PM2.0×3.0 screws (2) that secure the TouchPad button board to the
top cover.

4. Detach the TouchPad button board cable (1) from the top cover. (The TouchPad button board
cable is attached to the top cover with double-sided adhesive.)

5. Remove the TouchPad button board (2) and cable.

Reverse this procedure to install the TouchPad button board.
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Card reader board

Description Spare part number

Card reader board (includes cable and double-sided adhesive) 758043-001

Before removing the card reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

Remove the card reader board:

1. Turn the top cover upside down with the front toward you.

2. Detach the card reader board cable (1) from the top cover. (The card reader board cable is
attached to the top cover with double-sided adhesive.)

3. Remove the Philllips PM2.0×2.0 broad head screw (2) that secures the card reader board to the
top cover.
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4. Remove the card reader board (3) and cable.

Reverse this procedure to install the card reader board.

Power button board

Description Spare part number

Power button board (includes cable and double-sided adhesive) 758044-001

Before removing the power button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)
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Remove the power button board:

1. Turn the top cover upside down with the front toward you.

2. Detach the power button board cable (1) from the top cover. (The power button board cable is
attached to the top cover with double-sided adhesive.)

3. Remove the Philllips PM2.0×3.0 screw (2) that secures the power button board to the top cover.

4. Remove the power button board (3) and cable.

Reverse this procedure to install the power button board.

Speakers

Description Spare part number

Speaker Kit (includes left and right speakers and cables) 758053-001

Before removing the speakers, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)
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c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

Remove the speakers:

1. Disconnect the speaker cable (1) from the system board.

2. Detach the speaker cable (2) from the system board. (The speaker cable is attached to the system
board with tape.)

3. Remove the speakers (3).

Reverse this procedure to install the speakers.
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Audio/USB board

Description Spare part number

Audio/USB board (includes audio jack, USB port, and cable) 758046-001

Before removing the audio/USB board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

Remove the audio/USB board:

1. Release the ZIF connector (1) to which the audio/USB board cable is attached, and then
disconnect the audio/USB board cable from the system board.

2. Remove the Philllips PM2.5×4.5 screw (2) that secures the audio/USB board to the
base enclosure.

78 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



3. Remove the audio/USB board (3) and cable.

Reverse this procedure to install the audio/USB board.

System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Professional operating system

777342-601

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Standard operating system

777342-501

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and a non-Windows 8
operating system

777342-001

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Professional operating system

777341-601

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Standard operating system

777341-501
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Description Spare part number

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and a non-Windows 8
operating system

777341-001

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system

777340-601

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system

777340-501

Equipped with an AMD A8-6410 2.00-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and a non-
Windows 8 operating system

777340-001

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Professional operating system

764691-601

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Standard operating system

764691-501

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 2.0-GB of dedicated video memory (256×16 DDR3@1- GHz, 4 pieces), and a non-Windows
8operating system

764691-001

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Professional operating system

764689-601

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and the Windows 8
Standard operating system

764689-501

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up
to 1.0-GB of dedicated video memory (128×16 DDR3@1- GHz, 4 pieces), and a non-Windows
8operating system

764689-001

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system

764685-601

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system

764685-501

Equipped with an AMD A6-6310 1.80-GHz (turbo boost up to 2.40-GHz) processor (1600-MHz
FSB, 2.0-MB L2 cache, quad core, 15 W), a graphics subsystem with UMA memory, and a non-
Windows 8 operating system

764685-001
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Description Spare part number

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of dedicated
video memory (256×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Professional
operating system

764690-601

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of dedicated
video memory (256×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Standard operating system

764690-501

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 2.0-GB of dedicated
video memory (256×16 DDR3@1-GHz, 4 pieces), and a non-Windows 8 operating system

764690-001

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of dedicated
video memory (128×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Professional
operating system

764688-601

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of dedicated
video memory (128×16 DDR3@1-GHz, 4 pieces), and the Windows 8 Standard operating system

764688-501

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), an AMD Radeon R5 M240 graphics subsystem with up to 1.0-GB of dedicated
video memory (128×16 DDR3@1-GHz, 4 pieces), and a non-Windows 8 operating system

764688-001

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

764684-601

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

764684-501

Equipped with an AMD A4-6210 1.80-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, quad
core, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating system

764684-001

Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, dual
core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

764687-601

Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, dual
core, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

764687-501

Equipped with an AMD E2-6110 1.50-GHz processor (1600-MHz FSB, 2.0-MB L2 cache, dual
core, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating system

764687-001

Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2 cache, dual
core, 10 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

764686-601

Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2 cache, dual
core, 10 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

764686-501

Equipped with an AMD E1-6010 1.35-GHz processor (1333-MHz FSB, 1.0-MB L2 cache, dual
core, 10 W), a graphics subsystem with UMA memory, and a non-Windows operating system

764686-001
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Description Spare part number

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Professional
operating system

758035-601

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Standard
operating system

758035-501

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 7
operating system

758035-001

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Professional
operating system

758040-601

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Standard
operating system

758040-501

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 7
operating system

758040-001

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Professional
operating system

758034-601

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Standard
operating system

758034-501

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 7
operating system

758034-001

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Professional
operating system

758039-601

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Standard
operating system

758039-501

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 7
operating system

758039-001

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Professional
operating system

758033-601

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 8 Standard
operating system

758033-501

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the Windows 7
operating system

758033-001
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Description Spare part number

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Professional
operating system

758038-601

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 8 Standard
operating system

758038-501

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), an AMD Radeon
HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the Windows 7
operating system

758038-001

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 8 Professional operating system

758036-601

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 8 Standard operating system

758036-501

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 7 operating system

758036-001

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 8 Professional operating system

758041-601

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 8 Standard operating system

758041-501

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 7 operating system

758041-001

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 8 Professional operating system

758037-601

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 8 Standard operating system

758037-501

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 2.0-GB of discrete memory, and the
Windows 7 operating system

758037-001

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 8 Professional operating system

758042-601

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 8 Standard operating system

758042-501

Equipped with an Intel Celeron 2957U 1.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), an AMD Radeon HD 8670M graphics subsystem with 1.0-GB of discrete memory, and the
Windows 7 operating system

758042-001
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Description Spare part number

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Professional operating system

758030-601

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Standard operating system

758030-501

Equipped with an Intel Core i7-4500U 1.80-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 7 operating system

758030-001

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Professional operating system

758029-601

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Standard operating system

758029-501

Equipped with an Intel Core i5-4200U 1.60-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 7 operating system

758029-001

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Professional operating system

758028-601

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 8 Standard operating system

758028-501

Equipped with an Intel Core i3-4005U 1.70-GHz processor (dual core, 15 W), a graphics
subsystem with UMA memory, and the Windows 7 operating system

758028-001

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

758031-601

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard operating system

758031-501

Equipped with an Intel Pentium 3558U 1.70-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 7 operating system

758031-001

Equipped with an Intel Celeron 2957U 1.60-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

758032-601

Equipped with an Intel Celeron 2957U 1.60-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard operating system

758032-501

Equipped with an Intel Celeron 2957U 1.60-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 7 operating system

758032-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
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3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

f. Speakers (see Speakers on page 76)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 57)

● Solid-state drive (see Solid-state drive on page 59)

● Memory modules (see Memory module on page 60)

● RTC battery (see RTC battery on page 91)

● Heat sink (see Heat sink on page 87)

● Fan (see Fan on page 90)

Remove the system board:

1. Release the ground tape (1) that secures the display panel cable to the system board.

2. Release the ZIF connector (2) to which the display panel cable is attached, and then disconnect
the display panel cable from the system board.
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3. Release the ZIF connector (3) to which the audio/USB board cable is attached, and then
disconnect the audio/USB board cable from the system board.

4. Remove the fan cowling material (1) that forms a seal between the base enclosure and the fan.

5. Remove the two Philllips PM2.0×5.5 screws (2) that secure the system board to the
base enclosure.

6. Remove the four Philllips PM2.5×4.5 screws (3) that secure the system board to the
base enclosure.

7. Lift up on the right side of the system board (1) until it rests at an angle.

8. Disconnect the power connector cable (2) from the system board.
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9. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.

Heat sink

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on computer models equipped with a graphics subsystem with discrete memory 746658-001

For use only on computer models equipped with a graphics subsystem with UMA memory 746659-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)
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f. Speakers (see Speakers on page 76)

g. System board (see System board on page 79)

Remove the heat sink:

1. Turn the system board upside down with the front toward you.

2. Disconnect the fan cable (1) from the system board.

3. Following the 1 through 6 sequence stamped into the heat sink, loosen the six Phillips captive
screws (2) and (3) that secure the heat sink to the system board.

NOTE: The heat sink used on computer models equipped with a graphics subsystem with UMA
memory will only have the screws in location (2).

4. Remove the heat sink (4).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the
system board components each time the heat sink is removed. Replacement thermal material is included
with the heat sink and system board spare part kits. thermal material is used in the following locations:

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it.
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● A thermal pad is used on the graphics subsystem component (3) and the heat sink section (4) that
services it. The heat sink and system board used on computer models equipped with a graphics
subsystem with UMA memory will not have this component.

Reverse this procedure to install the heat sink.
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Fan

Description Spare part number

Fan (includes cable) 746657-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

f. Speakers (see Speakers on page 76)

g. System board (see System board on page 79)

h. Heat sink (see Heat sink on page 87)

Remove the fan:

1. Remove the cowling material (1) that secures the fan to the heat sink.
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2. Remove the fan (2).

Reverse this procedure to install the fan.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 718440-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

f. Speakers (see Speakers on page 76)

g. System board (see System board on page 79)
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Remove the RTC battery:

1. Turn the system board upside down with the front toward you.

2. Use a plastic flat-bladed tool (1) to release the RTC battery (2) from the socket on the
system board.

Reverse this procedure to install the RTC battery. When installing the RTC battery in the system board
socket, make sure the “+” is facing up.

Power connector cable

Description Spare part number

Power connector cable 758054-001

Before removing the power connector cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)
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d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

f. Speakers (see Speakers on page 76)

g. System board (see System board on page 79)

Remove the power connector cable:

1. Release the display panel cable (1) from the routing channel built into the base enclosure.

2. Release the power connector cable (2) from the routing channel built into the base enclosure.

3. Release the power connector (3) from the molding built into the base enclosure.

4. Remove the power connector cable.

Reverse this procedure to install the power connector cable.
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Display assembly

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the Battery (see Battery on page 52), and then remove the following components:

a. Service cover (see Service cover on page 53)

b. Hard drive (see Hard drive on page 54)

c. Optical drive (see Optical drive on page 62)

d. Keyboard (see Keyboard on page 64)

e. Top cover (see Top cover on page 67)

f. Speakers (see Speakers on page 76)

g. System board (see System board on page 79)

Remove the display assembly:

1. Release the display panel cable from the routing clips (1) and channel built into the
base enclosure.
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2. Release the wireless antenna cables from the routing clips (2) and channel built into the
base enclosure.

3. Remove the three Phillips PM2.5×4.5 screws (1) that secure the display assembly left hinge to the
base enclosure.

4. Remove the four Phillips PM2.5×3.25 broad head screws (2) that secure the display assembly
right hinge to the base enclosure.

5. Remove the display assembly (3).
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6. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the two display bezel screw covers (1).

b. Remove the two Phillips PM2.0×3.75 screws (2) that secure the display bezel to the
display assembly.

c. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

d. Remove the display bezel (4).

The display bezel is available using spare part numbers 758055-001 (for use only on
computer models equipped with a webcamera) and 758056-001 (for use only on computer
models not equipped with a webcamera).
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7. If it is necessary to replace the webcamera/microphone module:

a. Detach the webcamera/microphone module (1) from the display enclosure.
(The webcamera/microphone module is attached to the display enclosure with double-
sided adhesive.)

b. Disconnect the webcamera/microphone module cable (2) from the webcamera/
microphone module.

c. Remove the webcamera/microphone module.

The webcamera/microphone module is available using spare part number 746667-001.
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8. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the
display enclosure.

CAUTION: Before turning the display panel upside down, make sure the work surface is
clear of tools, screws, and any other foreign objects. Failure to follow this caution can result
in damage to the display panel.

b. Lift the top edge of the display panel (1) and swing it up and forward until it rests upside
down in front of the display enclosure.

c. Release the adhesive strip (2) that secures the display panel cable connector to the
display panel.
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d. Disconnect the display panel cable (3) from the display panel.

e. Remove the display panel.

The display panel is available using spare part number 761784-001.

9. If it is necessary to replace the display panel cable:

a. Release the display panel cable from the clips (1) and routing channel built into the the
display enclosure.
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b. Remove the display panel cable (2).

The display panel cable is available using spare part numbers 758059-001 (for use only on
computer models equipped with a webcamera) and 758058-001 (for use only on computer
models not equipped with a webcamera).

10. If it is necessary to replace the display hinges:

a. Remove the four Phillips PM2.5×3.25 broad head screws (1) that secure the display hinges
to the display enclosure.
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b. Remove the display hinges (2).

The display hinges are included in the Display Hinge Kit, spare part number 758061-001.

11. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided adhesive.)

b. Release the WLAN antenna cables from the clips (2) and routing channel built into the top
edge and right side of the display enclosure.
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c. Remove the WLAN antenna cables and transceivers (3).

The WLAN antenna cables and transceivers are included in the Antenna Kit, spare part
number 758060-001.

Reverse this procedure to reassemble install the display assembly.
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7 Computer Setup (BIOS)

Windows 8 – Computer Setup (BIOS), MultiBoot, and
HP PC Hardware Diagnostics (UEFI)

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of
the computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad or USB mouse) or the keyboard to
navigate and make selections in Computer Setup.

NOTE: Your pointing device may not function within the BIOS. If it does not, please use the
arrow keys to navigate.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the keyboard arrow keys and then press enter, or use a
pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-
screen instructions.

– or –

Use the esc key to exit. A prompt will appear, reading Exit Saving Changes? Select no to exit
without saving changes.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-
screen instructions.

– or –

Use the arrow keys to select Exit > Exit Saving Changes, and then press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Main and then press f9 for Setup Defaults.
When prompted to “Load Setup Defaults,” select Yes with the arrow keys, and then press enter.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining a BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Exit Saving Changes, and then press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type support assistant, and then select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type file, and then select File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.

You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.
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Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Advanced > Boot Options > UEFI Boot
Order for UEFI Hybrid or UEFI Native Boot mode, or select Advanced > Boot Options
> Legacy Boot Order for Legacy Boot Mode, and then press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Advanced > Boot Options> MultiBoot
Express Boot Popup Delay (Sec), and then press enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.
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Using HP PC Hardware Diagnostics (UEFI) (select models only)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
the operating system to isolate hardware failures from issues that may be caused by the
operating system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 110.

b. Hard drive

c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English
only.

1. Go to http://www.hp.com.

2. Click Support & Drivers, and then click the Drivers & Dowloads tab.

3. Enter the product name in the text box, and then click Go.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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Windows 7 – Computer Setup (BIOS), MultiBoot, and
HP PC Hardware Diagnostics (UEFI)

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of
the computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining a BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update for Windows 7

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting Start > Help and Support.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Select Start > Computer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.

You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.
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Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then
press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select System Configuration > Boot Options,
and then press enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.
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Using HP PC Hardware Diagnostics (UEFI) (select models only)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
the operating system to isolate hardware failures from issues that may be caused by the
operating system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools
in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 118.

b. Hard drive

c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.

1. Go to http://www.hp.com.

2. Click Support & Drivers, and then click the Drivers & Software tab.

3. Enter the product name in the text box, and then click Search.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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Linux – Computer Setup (BIOS) and Advanced
System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of
the computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.
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4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the startup
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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8 Specifications

 Metric U.S.

Dimensions

Width 38.40 cm 15.12 in

Depth 26.10 cm 10.28 in

Height 2.31 cm 0.91 in

Weight 2.30 kg 5.07 lb

Operating voltage and current 19.5 V dc @ 4.62 A– 90W

19.5 V dc @ 3.33 A – 65 W

NOTE: This product is designed for IT power systems in Norway
with phase-to-phase voltage not exceeding 240 V rms.

NOTE: The computer operating voltage and current can be found
on the system regulatory label.

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (non-condensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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9 Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant
on the Start screen, select the HP Support Assistant app.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

For more information on the Windows backup features, see HP Support Assistant. To access HP
Support Assistant, from the Start screen, select the HP Support Assistant app.
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Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Using Windows operating system media (purchased separately) on page 127.
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Using the Windows recovery tools

To recover information you previously backed up:

1. Access HP Support Assistant.

▲ To access HP Support Assistant, from the Start screen, select the HP Support Assistant
app.

2. Click Storage.

3. Click Backup and Recovery.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

From the Start screen, type file, and then click File Explorer.

– or –

From the Start screen, type pc, and then select This PC.

NOTE: If the Windows partition and the Recovery Image partition are not listed, you must
recover your operating system and programs using the Windows 8 operating system DVD and the
Driver Recovery media (both purchased separately). For additional information, see Using
Windows operating system media (purchased separately) on page 127.

3. If the Windows partition and the Recovery Image partition are listed, restart the computer by
pressing and holding the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in HP Support Assistant. To access HP Support Assistant on the Start screen,
select the HP Support Assistant app.
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Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type pc,
and then select This PC.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows operating system media
(purchased separately) on page 127.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers
booklet included with the computer. You can also find contact information from the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

CAUTION: Using a Windows operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows operating system DVD into the optical drive, and then restart the computer.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh or Windows Reset

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your computer, or remove
personal information before you give away or recycle your computer. For more information on these
features, see HP Support Assistant. To access HP Support Assistant, from the Start screen, select the HP
Support Assistant app.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

NOTE: Your computer may not come equipped with an internal optical drive. In order to create the
recovery DVD, you may need to plug in an external optical drive.

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media performs a system recovery if the hard drive becomes corrupted. A
system recovery reinstalls the original operating system and the software programs installed at the
factory, and then configures the settings for the programs.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications. Choosing
this selection creates a DVD that restores the original operating system and the software programs
installed at the factory.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: Operating system recovery media can be created only once. Thereafter, the option to create
that media will not be available.

1. Select Start > All Programs > Security and Protection > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after software
setup, you should create system repair discs (select models only) using HP Recovery Disc Creator using
the installed optical drive (select models only) or an optional external optical drive and back up your
system. As you add new software and data files, you should continue to back up your system on a
regular basis to maintain a reasonably current backup. The system repair discs (select models only) are
used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure
occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

130 Chapter 9   Backup and recovery



● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.

NOTE: Your computer may not come equipped with an internal optical drive. In order to create
back up discs, you may need to plug in an external optical drive.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see Using a Windows
7 operating system DVD (purchased separately) on page 134.

NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.
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Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see Using a Windows 7
operating system DVD (purchased separately) on page 134.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, see Using a Windows 7 operating system DVD
(purchased separately) on page 134.

NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Linux
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.needed.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see
Performing a system recovery on page 136.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly
scheduled time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image, using an installed or an external DVD±RW optical drive.

NOTE: Your computer may not come equipped with an internal optical drive. In order to create the
HP Factory Image, you may need to plug in an external optical drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery ISO file and then
burn it to an optical disc.

NOTE: HP recommends that you create the HP Factory Image in the event of a system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image in the right pane.

3. Enter the root password when prompted.

4. Right-click on the HP_Recovery.iso file and select Open with Brasero.

5. Insert a blank DVD disc and select Burn. This creates the HP Factory Image Restore DVD.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Select Optical Disk Drive from the Boot Options menu and press enter.

5. Press enter to select Restore System from Media.

6. At both of the System Recovery prompts, select Yes.
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Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux
operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

To reinstall SLED, follow the steps below.

1. Select System Recovery from the boot menu after pressing f11.

2. A prompt will appear, reading, “This utility will wipe out your hard drive contents and restore your
PC to factory state. Are you sure you want to continue?” Select Yes.

3. A prompt will appear, reading, “Please confirm you want to restore your system to factory state
and lose all your current data.” Select Yes.
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10 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in
industry-standards based HP Business Notebook PC systems and provide general instructions for
restoring nonvolatile memory that can contain personal data after the system has been powered off and
the hard drive has been removed.

HP Business Notebook PC products that use Intel-based or AMD®-based system boards contain volatile
DDR memory. The amount of nonvolatile memory present in the system depends upon the system
configuration. Intel-based and AMD-based system boards contain nonvolatile memory subcomponents
as originally shipped from HP assuming that no subsequent modifications have been made to the
system and assuming that no applications, features, or functionality have been added to or installed on
the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC
system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and
will also remain in nonvolatile memory. The steps below will remove personal data from the notebook
PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of
these steps are disclosed in the Maintenance and Service Guides available for HP PC products
available on the product support pages at www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal
data. Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near
the bottom of the display, or press the ESC key to display the start up menu, then press F10 .
If the system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities
menu. Select System IDs, and then select the tag that has been set. Press the spacebar
once to clear the tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then
select DriveLock password. Select the desired hard drive. Click Disable protection,
enter the existing master DriveLock password, then press Enter to confirm and return to the
prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
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f. If an Automatic DriveLock password is set, select the Security menu, scroll down to
Automatic DriveLock, then select the desired hard drive and disable protection. Repeat
this procedure if more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the
warning message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module and/or fingerprint sensor, one
or two prompts will appear: one to clear the TPM and the other to reset fingerprint sensor.
Press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel Centrino with
VProTM, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select
System Configuration, then AMT Options. Then select Un-configure AMT on next
boot. Select Save, then Yes. Select the File menu, and then select Save Changes and
Exit. Reboot the system and confirm that you want to un-configure AMT.

j. If the optional Intel Anti-Theft Technology (AT) was activated, contact the provider to
deactivate it.

k. If the optional Absolute® Software Computrace® management and tracking service was
activated on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application
that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10
when prompted near the bottom of the display, or press ESC to display the start up menu,
then press F10. Select the Security menu and scroll down to the Utilities menu. Select
Disk Sanitizer and select the desired drive. For a higher level of protection, select
Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard
drive capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a
third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup
by powering on the system and pressing F10 when prompted near the bottom of the display.
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and
select the desired hard drive.
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Non-volatile memory usage

Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory
(CMOS)

256 Bytes No Yes Stores system
date and time
and limited
keyboard
controller data.

Using the F10
Setup utility or
changing the
Microsoft
Windows date
and time.

This memory is
not write-
protected. HP
recommends
password
protecting the
F10 Setup
utility.

Controller (NIC)
EEPROM

64 KBytes (not
customer
accessible)

No Yes Store NIC
configuration
and NIC
firmware.

Using a utility
from the NIC
vendor that can
be run from
DOS.

A utility is
required to
write data to
this memory
and is available
from NIC
vendor. Writing
data to this
ROM in an
inappropriate
manner will
render the NIC
nonfunctional.

Keyboard ROM 64 KBytes (not
customer
accessible)

No Yes Stores firmware
code
(keyboard,
mouse, &
battery
management).

Programmed at
the factory.
Code is
updated when
the system BIOS
is updated.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.

DIMM Serial
Presence Detect
(SPD)
configuration
data

256 Bytes per
memory
module, 128
Bytes
programmable
(not customer
accessible)

No Yes Stores memory
module
information.

Programmed by
the memory
vendor.

Data cannot be
written to this
memory when
the module is
installed in a
PC. The specific
write protection
method varies
by memory
vendor.
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

System BIOS 4 to 5 MBytes Yes Yes Store system
BIOS code and
PC
configuration
data.

System BIOS
code is
programmed at
the factory.
Code is
updated when
the system BIOS
is updated.
Configuration
data and
settings are
input using the
F10 setup utility
or a custom
utility.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.

Intel
Management
Engine
Firmware
(present only in
models ending
in a ‘p’ or ‘w’
or with Intel
Centrino Pro
technology)

1.5 or 5
MBytes

Yes Yes Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party data
store.

Management
Engine Code is
programmed at
the factory.
Code is
updated via
Intel secure
firmware
update utility.
Unique
Provisioning
Data can be
entered at the
factory or by an
administrator
using the
Management
Engine (MEBx)
setup utility. The
third party data
store contents
can populated
by a remote
management
console or local
applications
registered by
an
administrator to
have access to
the space.

The Intel chipset
is configured to
enforce
hardware
protection to
block all direct
read/write
access to this
area. An Intel
utility is
required for
updating the
firmware. Only
firmware
updates
digitally signed
by Intel can be
applied using
this utility.
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Bluetooth flash 2 MBits No Yes Stores Bluetooth
configuration
and firmware.

Programmed at
the factory.
Tools for writing
data to this
memory are not
publicly
available but
can be
obtained from
the silicon
vendor.

A utility is
required for
writing data to
this memory
and is made
available
through newer
versions of the
driver if the
flash requires
an upgrade.

802.11 WLAN
EEPROM

4 KBytes to 8
KBytes

No Yes Stores
configuration
and calibration
data.

Programmed at
the factory.
Tools for writing
data to this
memory are not
made public.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Webcamera 64 KBits No Yes Store
webcamera
configuration
and firmware.

Using a utility
from the device
manufacturer
that can be run
from Windows.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Fingerprint
reader

512 KBytes
flash

Yes Yes Stores
fingerprint
templates.

By enrolling in
HP ProtectTools
Security
Manager.

Only a digitally
signed
application can
make the call to
write to the
flash.
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Questions and answers
1. How can the BIOS settings be restored (returned to default settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect
(SPD) memory module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial
number, data width, speed/timing, voltage and thermal information. This information is written by
the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the
memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when
the memory module is not installed in a PC. There are various third party tools available to read
SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip
writable, and if so how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform
the write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip
so that updates can be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. What is meant by “Restore the nonvolatile memory found in Intel-based
system boards?”

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC
configuration data.

6. Does resetting the CMOS configuration memory return the PC back to
factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their default settings. To return these
system data and configuration defaults to default settings, refer to question and answer 1 and
follow the instructions for returning the BIOS settings to factory defaults.
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11 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
Requirements for all countries 113

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1
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Country/region Accredited agency Applicable note number

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden CEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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12 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.

146 Chapter 12   Recycling

http://www.hp.com/recycle


Index

A
AC adapter light 17
AC adapter, spare part numbers

34, 37
antenna

location 11
removal 101
spare part number 32, 42,

102
Antenna Kit, spare part number

32, 42, 102
audio, product description 6
audio-in jack 18
audio-out jack 18
audio/USB board

removal 78
spare part number 28, 42, 78

B
base enclosure, spare part

number 29, 42
battery

removal 52
spare part number 29, 37, 52

battery bay 19
battery cover lock 19
battery cover release latch 19
battery light 17
bottom components 19
button components 12
buttons

optical drive eject 18
power 12
TouchPad 15
TouchPad on/off 15
Windows 13

C
cables, service considerations 47

caps lock light 15
card reader board

removal 74
spare part number 22, 42, 74

carrying case, spare part
numbers 34, 36, 37

chipset, product description 2
components

bottom 19
buttons 12
display 11
fingerprint reader 12
front 16
keys 13
left side 17
lights 14
right side 18
TouchPad 15

computer
major components 21
specifications 123

connectors, service
considerations 47

D
display assembly

removal 94
spare part numbers 31

display bezel
removal 96
spare part numbers 31, 42,

45, 96
display components 11
display enclosure, spare part

number 32, 42
Display Hinge Kit, spare part

number 31, 42, 101
display panel

product description 2

removal 98
spare part number 31, 43, 99

display panel cable
removal 99
spare part numbers 32, 42,

100
drives, preventing damage 47
DVD±RW Double Layer with

SuperMulti Drive
precautions 47
removal 62
spare part number 62
spare part numbers 29, 33,

43, 45

E
electrostatic discharge 48
equipment guidelines 50
esc key 13
Ethernet, product description 6
external expansion, product

description 7
external monitor port 17

F
fan

removal 90
spare part number 28, 37, 90

fingerprint reader 13, 14
fingerprint reader component 12
fingerprint reader module

removal 71
spare part number 23, 42, 71

flash cache, product description 4
fn key 13
front component 16
function keys 13

Index 147



G
graphics, product description 3
grounding guidelines 48
guidelines

equipment 50
grounding 48
packaging 49
transporting 49
workstation 49

H
hard drive

precautions 47
product description 5
removal 54
spare part numbers 29, 33,

36, 37, 54
hard drive bracket

illustrated 34
removal 55

hard drive connector adapter
illustrated 34
removal 56

Hard Drive Hardware Kit
contents 33
spare part number 33, 42

hard drive light 18
HDMI port 17
HDMI-to-VGA adapter, spare part

number 34, 37
headphone jack 18
heat sink

removal 87
spare part numbers 28, 37,

87
hinge

removal 100
spare part number 31, 42,

101

J
jacks

audio-in 18
audio-out 18
headphone 18
microphone 18
network 17
RJ-45 17

K
key components 13

keyboard
product description 7
removal 64
spare part numbers 22, 38,

39, 64
keys

esc 13
fn 13
function 13

L
left-side components 17
light components 14
lights

AC adapter 17
battery 17
caps lock 15
hard drive 18
mute 14
power 14, 18
TouchPad 15
TouchPad on/off 15
webcameraa 11
wireless 14

lock, spare part number 34, 37

M
mass storage device

illustrated 33
precautions 47
spare part numbers 33

memory module
product description 4
removal 60
spare part numbers 29, 36,

37, 60
memory module compartment cover

illustrated 32
location 19
removal 60
spare part number 61

microphone
location 11
product description 6

microphone jack 18
model name 1
mouse, spare part numbers 34,

36, 37
mute light 14

N
network jack 17

O
operating system, product

description 9
optical drive

location 18
precautions 47
product description 5
removal 62
spare part number 62
spare part numbers 29, 33,

43, 45
optical drive bay space saver,

illustrated 32
optical drive cable

spare part number 28, 43
optical drive eject button 18
Optical Drive Hardware Kit, spare

part number 29, 33, 42, 62

P
packaging guidelines 49
plastic parts, service

considerations 46
Plastics Kit

components 32
spare part number 29, 32, 42

pointing device, product
description 7

ports
external monitor 17
HDMI 17
product description 7
USB 2.0 18
USB 3.0 charging 17

power button 12
power button board

removal 75
spare part number 23, 42, 75

power connector 17
power connector cable

removal 92
spare part number 29, 42, 92

power cord
set requirements 144
spare part numbers 34, 35,

36, 37, 38
power light 14, 18

148 Index



power requirements, product
description 8

processor, product description 1
product description

audio 6
chipset 2
display panel 2
Ethernet 6
external expansion 7
flash cache 4
graphics 3
hard drive 5
keyboard 7
memory module 4
microphone 6
operating system 9
optical drive 5
pointing device 7
ports 7
power requirements 8
primary storage 5
processor 1
product name 1
security 8
serviceability 10
solid-state drive 4
video 6
wireless networking 6

product name 1

R
removal/replacement

procedures 51, 67
right-side components 18
RJ-45 jack 17
RTC battery

removal 91
spare part number 28, 37, 91

Rubber Kit, spare part number
29, 43

S
Screw Kit, spare part number 35,

43
security cable slot 18
security, product description 8
service considerations

cables 47
connectors 47
plastic parts 46

service cover
illustrated 32
location 19
removal 53
spare part number 53

serviceability, product description
10

solid-state drive
precautions 47
product description 4
removal 59
spare part number 29, 33,

37, 59
Speaker Kit, spare part number

23, 76
speakers

location 13
removal 76
spare part number 23, 42, 76

specifications 123
system board

removal 79
spare part numbers 23, 39,

40, 41, 42, 43, 44, 45, 79

T
tools required 46
top cover

removal 67
spare part numbers 22, 42,

67
TouchPad button 15
TouchPad button board

removal 72
spare part number 23, 42, 72

TouchPad components 15
TouchPad light 15
TouchPad on/off button 15
TouchPad on/off light 15
TouchPad zone 15
transporting guidelines 49

U
USB 2.0 port 18
USB 3.0 charging port 17

V
vents 17, 19
video, product description 6

W
webcam/microphone module

spare part numbers 31, 37,
45

webcamera 11
webcamera light 11
webcamera/microphone module

removal 97
spare part number 97

Windows button 13
wireless antenna

location 11
removal 101
spare part number 32, 42,

102
wireless light 14
wireless networking, product

description 6
WLAN module

removal 57
spare part numbers 29, 36,

37, 57
workstation guidelines 49

Index 149


	Product description
	Product Name
	Processor
	Chipset
	Panel
	Graphics
	Memory
	Flash cache
	Primary storage
	Optical drive
	Audio and video
	Ethernet
	Wireless networking
	External expansion
	Ports
	Keyboard/pointing devices
	Power requirements
	Security
	Operating system
	Serviceability

	External component identification
	Display
	Buttons, speakers, and fingerprint reader (select models only)
	Keys
	Lights
	TouchPad
	Front
	Left side
	Right side
	Bottom

	Illustrated parts catalog
	Locating the serial number, product number, and model number
	Computer major components
	Display assembly components
	Plastics Kit
	Mass storage devices
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement preliminary requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines





	Removal and replacement procedures for Customer Self-Repair parts
	Component replacement procedures
	Battery
	Service cover
	Hard drive
	WLAN module
	Solid-state drive
	Memory module
	Optical drive
	Keyboard


	Removal and replacement procedures for Authorized Service Provider parts
	Component replacement procedures
	Top cover
	Fingerprint reader module
	TouchPad button board
	Card reader board
	Power button board
	Speakers
	Audio/USB board
	System board
	Heat sink
	Fan
	RTC battery
	Power connector cable
	Display assembly


	Computer Setup (BIOS)
	Windows 8 – Computer Setup (BIOS), MultiBoot, and HP PC Hardware Diagnostics (UEFI)
	Using Computer Setup
	Starting Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup
	Updating the BIOS
	Determining a BIOS version
	Downloading a BIOS update


	Using MultiBoot
	About the boot device order
	Choosing MultiBoot preferences
	Setting a new boot order in Computer Setup
	Dynamically choosing a boot device using the f9 prompt
	Setting a MultiBoot Express prompt
	Entering MultiBoot Express preferences


	Using HP PC Hardware Diagnostics (UEFI) (select models only)
	Downloading HP PC Hardware Diagnostics (UEFI) to a USB device


	Windows 7 – Computer Setup (BIOS), MultiBoot, and HP PC Hardware Diagnostics (UEFI)
	Using Computer Setup
	Starting Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup
	Updating the BIOS
	Determining a BIOS version
	Downloading a BIOS update for Windows 7


	Using MultiBoot
	About the boot device order
	Choosing MultiBoot preferences
	Setting a new boot order in Computer Setup
	Dynamically choosing a boot device using the f9 prompt
	Setting a MultiBoot Express prompt
	Entering MultiBoot Express preferences


	Using HP PC Hardware Diagnostics (UEFI) (select models only)
	Downloading HP PC Hardware Diagnostics (UEFI) to a USB device


	Linux – Computer Setup (BIOS) and Advanced System Diagnostics
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update

	Using Advanced System Diagnostics


	Specifications
	Backup and recovery
	Windows 8
	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using Windows operating system media (purchased separately)
	Using Windows Refresh or Windows Reset
	Using HP Software Setup


	Windows 7
	Creating recovery media with HP Recovery Disc Creator
	Creating recovery media

	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using a Windows 7 operating system DVD (purchased separately)


	Linux
	Creating backups
	Backing up your information
	Performing a system recovery
	Remove everything and reinstall SLED


	Statement of Volatility
	Non-volatile memory usage
	Questions and answers

	Power cord set requirements
	Requirements for all countries
	Requirements for specific countries and regions

	Recycling
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends false
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /Warning
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /Warning
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 550
  /MonoImageMinResolutionPolicy /Warning
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 2400
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /PDFX3:2002
  ]
  /PDFX1aCheck false
  /PDFX3Check true
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    36.00000
    36.00000
    36.00000
    36.00000
  ]
  /PDFXSetBleedBoxToMediaBox false
  /PDFXBleedBoxToTrimBoxOffset [
    14.40000
    14.40000
    14.40000
    14.40000
  ]
  /PDFXOutputIntentProfile (ISO Coated v2 \050ECI\051)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Original PDF setting SheetSpotHiRes_1v4.joboptions from Ghent PDF Workgroup - 2008 Specifications version 4 \(PDF/X-1a:2001 compliant\) UNCHANGED but simply renamed for HPIE use.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [14173.229 14173.229]
>> setpagedevice


